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New Hire / Rehire Orientation
UIC Corporate & Commercial
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Agenda

• Welcome and Introduction

• Company Overview

• Company Policies

• UKG Pro (Human Capital Management System)

• Payroll and Timesheets

• Benefits

• Break

• Safety Orientation
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Company Overview
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About The Company

 Ukpeaġvik Iñupiat Corporation (UIC) is the village corporation for Barrow, 
Alaska. Barrow is home to more than 4,500 people, the majority of whom 
are Alaska Native Iñupiat.

 UIC provides economic resources to more than 2,900 Iñupiat shareholders 
and their descendants. 

 UIC consistently ranks among the top largest Alaskan-owned companies. 

 UIC employs more than 3,000 people worldwide.

Who We Are
~ Recognized business leader
~ Shareholder value
~ Quality services and products
~ Consistent profitability

BUSINESS VALUES
Cooperation

Family and Kinship

Humility

Humor

Hunting Traditions and Respect 
for Nature

Knowledge of Language

Love and respect for our Elders 
and one another

Sharing

Spirituality

UIC Family of Companies

• UIC Commercial Services

• UIC Government Services, LLC

• UIC Government Construction
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The Heart of Our Culture

As the whaling seasons approach, the bowhead whales prepare for their 
journey north and east. They travel from the Bering Sea, through the Bering 
Strait, into the Chukchi Sea, and finally arrive at the Beaufort Sea.

Along the way, they come across hunters awaiting in their Umiaqs – “skin-
covered boats”.  Some boats appear light in color, clean, and pleasing to the 
eye as “Clean Umiaqs”.

If a bowhead whale wishes to give itself to a whaling crew, it will surface next 
to a Clean Umiaq. These boats belong to respectful people, people who are 
considerate of others. Whom share their catch with widows, orphans, the old, 
and all those who could not hunt for themselves. They are honest, they treat 
other people and all animals with respect.

These are the hunters to whom whales want to give themselves to.

A Clean Umiaq

.....................................................................................................
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UIC Cultural Video

 UIC and the family of companies are rich in culture and values. The short 
video you are about to view gives more information on company origins and 
our Shareholder way of life.

UIC Cultural Video

 You may view the full video at your leisure by visiting the link below:

UIC Cultural Video (full version)

Our Story: Thousands of Years in the Making

.....................................................................................................

http://www.youtube.com/watch?v=wyU0__RUbrQ
http://www.youtube.com/watch?v=MxOfqTUaFrU&feature=youtube
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Our Vision and Mission

Vision Statement

Ukpeaġvik Iñupiat Corporation will be the recognized business leader for 
providing shareholder value, quality services and products, and consistent 
profitability.

Mission Statement

To enhance the lives of our shareholders by bringing our Iñupiat values to the 
services and products we provide to our customers.

Ukpeaġvik Iñupiat Corporation

.....................................................................................................
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Our Values

Our Inupiat Values:

– Love and Respect for Our Elders & One Another
– Compassion
– Cooperation
– Family and Kinship
– Knowledge of Language
– Respect for Nature

– Sharing
– Resolution of Conflict
– Humor
– Spirituality
– Hunting Traditions
– Humility

UICCS is committed to the following principles:

– We conduct all our business honestly, cooperatively, and effectively.
– We assist every client to improve business practices and reduce cost.
– We enhance the socio-economic status of our shareholders while 

supporting our culture as a whole.

U k p e a ġ v i k
I ñ u p i a t

C o r p o r a t i o n

Sivuniqsuutivut:
Guiding Principles

Isumasaasuqtuat:
Our Wisdom

Suaŋativut:
Our Strength

Inuvut:
Our People

.....................................................................................................
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UIC Global Footprint
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Code of Business Ethics

This is what UIC and its board of directors, officers, and employees strive to be; 
and what we expect of everyone with whom we do business.

 Ethical practices should be incorporated into daily business and everyday 
transactions by following the general principles of this Code which include 
the following:

▫ Respect the law.
▫ Act with integrity by being honest, fair, and respectful to others.
▫ Protect the interests of the company and our shareholders.
▫ Be professional and make ethical conduct part of UIC’s culture.

 There are five questions to ask yourself to help incorporate UIC’s Code of 
Ethics into the daily business:

▫ Is it legal?
▫ Is it honest?
▫ Is it fair?
▫ Is it in UIC’s best interest?
▫ Does it fit UIC’s culture?

Policy Statement and Guiding Principles

.....................................................................................................
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UIC Commercial Services

 UIC Commercial Services (UICCS) is a holding company of 12 subsidiary 
companies that predominantly operate in and around the state of Alaska. 
These companies provide an array of services such as:

▫ Design and Permitting

▫ Commercial, Industrial, and Heavy Civil Construction

▫ Environmental Remediation 

▫ Marine Transport 

▫ Oil and Gas Support 

▫ Municipal Services 

▫ Real Estate Management

▫ Small Disadvantaged Business and 8(a) certified Operations

Business Lines & Services

.....................................................................................................
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UIC Commercial Services Organization

UIC Oil & Gas
Don Gray

Qayaq Marine Transportation
Don Gray

Umiaq Environmental
Terri Mitchell - GM

Industrial, Marine & Environmental
Don Gray, Director

Umiaq Design
Wiley Wilhelm - GM

UIC Nappairit
Bill McCormick - GM

UIC Construction
Justin Jones - GM

UIC Construction ASRC Eskimo’s
Justin Jones - GM

Qayaq Construction
Kodi Long - GM

Design & Construction
Clayton Arterburn, Director

Bowhead Transport
Chris Palle - GM

UIC Science
Nagruk Harcharek

Barrow Operations
Nagruk Harcharek, Director

UIC Real Estate
Vernon Edwardsen - GM

UIC Board of Directors
President and

Chief Executive Officer, UIC
Delbert Rexford

Sr. VP of UIC Commercial Services
Clayton Arterburn

Municipal Services
Nagruk Harcharek 

Chief Operating Officer UIC
Jeevan Pokharel

Chief Financial Officer UIC
Joe Stanich

Sr Director of 
Finance

Steve Louk

Corp Sr. Director 
of IT

Ted Rayhart

Corp Sr. Director 
of HSET & Risk
Chris Monetta

Sr HR Manager
Selma Khan
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Company Policies
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Equal Employment Opportunity Policy

It is the Policy that The Company shall not discriminate against any employee or applicant because of 
race, color, religion, creed, sex, sexual orientation, gender or gender identity (except where gender is a 
bona fide occupational qualification), pregnancy, national origin, age, disability, military/veteran status, 
marital status, or genetic information. The Company is committed to the principle that all employees are 
entitled to equal opportunities in all aspects of employment.

The Company shall ensure that the Company’s employment practices and other personnel actions are 
administered in a lawful and nondiscriminatory manner. This policy applies to all areas of employment, 
including recruitment, hiring, training, promotion, transfers, reassignments, career development 
opportunities, compensation, benefits, and social and recreational programs. The Company’s employment 
practices shall be based on established merit principles of performance and qualifications. The Company 
is committed to providing reasonable accommodation to qualified individuals in accordance with the 
Disability Accommodation policy.

Any employee of the Company who fails to comply with this EEO policy shall be subject to disciplinary 
action, up to and including termination.
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Affirmative Action Policy

It is the Policy of the Company to take affirmative action to ensure equal employment opportunity in all 
Company policies and practices regarding recruiting, hiring, transfers, promotions, compensation, 
benefits, training, layoffs, and recalls from layoff. These policies and practices are administered without 
regard to race, color, religion, ancestry, national origin, age, disability, genetic information, sex (except 
where sex is a bona fide occupational qualification), marital status, and sexual orientation or veteran 
status. The Company’s commitment to equal employment opportunity, including reasonable 
accommodations and freedom from harassment, are set forth in this and other Company policies.

The Company recognizes that hiring and other employment difficulties may be experienced by women, 
pregnant individuals, minorities, individuals with disabilities, and veterans. The Company is committed to 
the full and fair utilization of such persons in the workforce. Special measures may be required to achieve 
affirmative action within an organization and the Company promotes a determined and sustained effort in 
support of this Affirmative Action Policy Statement. It is the policy of the Company to take affirmative 
action to employ, and to advance in employment, all persons regardless of their status and to base all 
employment decisions only on valid job requirements. This effort includes the development and utilization 
of Affirmative Action Plans that may be required of the Company as a condition of certain federal 
contracts.

The Company shall work cooperatively with government agencies and civic and community organizations 
to take affirmative action to ensure equal employment and advancement opportunities.
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Harassment-Free Workplace Policy

 Workplace Harassment is: 

▫ A form of employment discrimination when there is unwelcomed verbal
or physical conduct based on race, color, religion, sex, national origin, 
age, disability or genetic information.

 Workplace Harassment can occur, but is not limited to, when:

▫ The harasser can be the victim's supervisor, a supervisor in another 
area, an agent of the employer, a co-worker, or even a non-employee.

▫ The victim does not have to be the person harassed, but can be 
anyone affected by the offensive conduct.

▫ Unlawful harassment may occur without economic injury to, or 
discharge of, the victim.

Workplace Harassment

 Title VII of the Civil Rights 
Act of 1964

 Age Discrimination in 
Employment Act of 1967

 Americans with Disabilities 
Act of 1990

UIC is a ZERO-TOLERANCE employer 

.....................................................................................................
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Harassment-Free Workplace Policy

 Some Examples of How A Hostile Work Environment May Be Created

 Human Trafficking (FAR 52.222-50)

▫ UIC is strongly against the act of human trafficking.
▫ To report any practices of human trafficking please contact the Global 

Human Trafficking Hotline at 844-888-FREE or email help@befree.org.

Workplace Harassment continued

By making an 
offensive remark 

about one’s looks, 
clothing, or race

Any comment 
about one’s skin 
color or ethnic 

features

Any negative 
comment about 
one’s religious 

practices

Or any derogatory 
comments about 
one’s physical or 

mental impairment

REFERENCES

UKG Pro System

- hr.uicalaska.com

HR Department Contact

- HRCommercial@uiccs.com

If you have any questions concerning the policy or believe you are the victim of workplace 
harassment please contact Your HR Department at: HRCommercial@UICCS.com.

The Company policy for Harassment-Free workplace can be found on UIC’s UKG Pro system at: 
hr.uicalaska.com.

.....................................................................................................

mailto:help@befree.org
mailto:HRCommercial@uiccs.com
mailto:HRCommercial@UICCS.com
http://www.hr.uicalaska.com/
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Employee Conduct Policy

 We expect you to conduct yourself with pride and respect associated with 
your position, fellow employees, customers, suppliers, and everyone 
associated with the Company in one form or another.

 The expectations for employee conduct include:
▫ Honesty & Integrity 

▫ Loyalty to the Company 

▫ Business Ethics & Practices 

▫ Respect to Co-Workers/Customers/Business Partners/Suppliers 

▫ Job Performance 

▫ Safety Practices

▫ Ethical Conduct 

▫ Follow Company Policies Written in the Employee Handbook

Expectations of Employee Conduct

The Company policy for Employee Conduct can be found on UIC’s UKG Pro system at: hr.uicalaska.com.

.....................................................................................................

http://www.hr.uicalaska.com/
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Drug & Alcohol Abuse Prevention

 Substance-abuse prevention is everyone's responsibility. 

 UIC expects all of its employees to recognize and accept this responsibility, 
and to do their part in ensuring that, working together, we can achieve and 
maintain a drug-free work environment for all UIC employees. 

 This policy applies equally to all UIC personnel, no matter what position or 
employment status. 

UIC Company PolicyTested Drug Families

Methamphetamines

Cocaine

Amphetamines

Opiates

Phencyclidine

Benzodiazepine

Marijuana

Barbiturates

Methadone

Oxycodone

MDMA (Ecstasy)

Buprenorphine

Tested by Evidential 
Breath Testing Device: 

Alcohol

The Company policy for Drugs and Alcohol Abuse Prevention can be found on UIC’s UKG Pro system at: 
hr.uicalaska.com.

http://www.hr.uicalaska.com/
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Conflict of Interest Policy

 Conflict of Interest is an actual or potential situation to influence a decision or 
have business dealings that may result in a personal gain for you or one of 
your relatives.

 Some examples where a Conflict of Interest may occur include: 

▫ Decisions Involving Friends or Families
▫ Gifts & Entertainment
▫ Outside Employment
▫ Bonuses
▫ Discounts
▫ Favors
▫ Other Opportunities that Provide You with Personal Gain

What is Conflict of Interest

The Company policy for Conflict of Interest can be found on UIC’s UKG Pro system at: hr.uicalaska.com.

.....................................................................................................

http://www.hr.uicalaska.com/
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Conflict of Interest Policy

 The Company reasonably expects you to devote your best efforts, energies and skills to 
the discharge of your job duties. Outside employment may not create a conflict with your 
work schedule, responsibilities, or performance with UIC.  Outside employment must be 
approved in writing in advance by the Subsidiary General Manager in consultation with 
Human Resources. To avoid a conflict of interest:

▫ You must disclose and receive approval for all outside employment.  
▫ You may not conduct outside employment activities during work hours.
▫ You may not conduct outside employment activities using Bowhead facilities or 

equipment.
▫ You may not be employed/act as a director, officer, employee, consultant, agent, or 

independent contractor with a company that does business with or competes with 
UIC or the subsidiary companies.

 Outside Employment Form

▫ To obtain the UIC Conflict of Interest Outside Employment Request Form, please 
contact your supervisor or human recourses.  The form must be completed and 
submitted to HR for approval. 

Conflict of Interest: Outside Employment

The Company policy for Conflict of Interest can be found on UIC’s UKG Pro system at: hr.uicalaska.com.

.....................................................................................................

http://www.hr.uicalaska.com/
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Employee Handbook

Where to Find the Employee 
Handbook

The handbook is accessible from 
the UKG Pro (UP) homepage at 
hr.uicalaska.com

It is important to ALWAYS access 
the handbook from the UKG Pro 
system to get the most updated 
version.

hr.uicalaska.com
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Reminders

 If you have not done so, you MUST complete all onboarding paperwork in 
the UKG Pro system, including tax forms and the I-9 form.

 Provide the required identification by the end of your first day of 
employment. 

 This is VITAL for the initial set-up in the Payroll System in order for you to 
receive your 1ST PAY CHECK on time.

Please Note: 

Your first pay check will be mailed to you via US Postal Service. 

Direct deposit set-up will take a pay cycle to complete.

Action Items: HR & Payroll

.....................................................................................................
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UKG Pro
Human Capital Management System
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Human Capital Management System

UKG Pro/HCM Login

HIGHLIGHTS:

 UKG Pro is your Human 
Capital Management 
System or HCM

 Chrome or Microsoft Edge 
is the preferred browser

 Navigate to 
hr.uicalaska.com

.....................................................................................................

Google Chrome or Microsoft Edge is the preferred browser for UKG

To access UKG Pro enter/save into the browser hr.uicalaska.com.

If you are asked for login info, use the following:
Username: your Company email address
Password: your password you used when you set‐up your email address

If you encounter problems, try the following steps:
1. Turn off pop up blocker (Go to Tools > Pop‐up Blocker > Pop‐up Blocker 

Settings)
2. If you continue to have issues logging in please submit a Helpdesk ticket 

for assistance: ITHelpDesk@uicalaska.com.



26Proprietary Information – Do not distribute WWW.UICALASKA.COM

UKG Pro – Homepage

On the homepage of UKG you will find 
links for lots of information including:

 BENEFIT information

 FORMS to update your information 

 The EMPLOYEE HANDBOOK
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UKG Self-Service Features

Click on Menu  Myself 
to see Self-Service Features

 Add/Update your address and 
phone numbers

 Add/Change emergency contacts, 
dependents, and beneficiaries

 Add/Change direct deposit 
information

 View/Change tax information

 Upload a document to your personnel 
record

 Update benefits when you have a life 
changing event with “Life Events”

 Participate in benefit open enrollment

 Opt in/out of paper pay statements
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UKG Self-Service Features

To check the status of a requested 
change, navigate to your Inbox.

From the homepage, click:   

Menu  Inbox
 Completed – Approved, Denied, Etc.
 In Progress
 Pending Approval
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UIC University

UIC University is an online learning management system with training content 
that will enhance both your personal and professional development, at no cost to 
you, with the aim to aid you in reaching your career goals! 

In addition to ClickSafety and Navex, we have OpenSesame, that offers over 
6,000 courses that cover various topics. Their course offerings are expansive 
and include topics such as Microsoft Office, IT Certifications, Communication, 
Compliance, Ethics, and much more. Enhancements include:

▫ Simple training course searches, as well as a wide-variety of updated 
learning plans.

▫ Easy course navigation to fit your schedule.  You can start, stop, and 
restart training course without worrying about losing any of your work.

▫ Engaging, updated training courses that hold your attention and make 
learning enjoyable.

Microsoft Office

IT Certifications

Communication

Compliance

Ethics
Training content will be monitored and updated periodically

Welcome to the UIC University
Learning Management System (LMS)!

.....................................................................................................
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UIC University Login

Google Chrome or Microsoft Edge is the preferred browser for UKG

To access UKG Pro enter/save into the browser hr.uicalaska.com.

If you are asked for login info, use the following:
Username: your Company email address
Password: your password you used when you set‐up your email address

If you encounter problems, try the following steps:
1. Turn off pop up blocker (Go to Tools > Pop‐up Blocker > Pop‐up Blocker Settings)
2. If you continue to have issues logging in please submit a Helpdesk ticket for assistance: 

ITHelpDesk@uicalaska.com.

Microsoft Office

IT Certifications

Communication

Compliance

Ethics

.....................................................................................................
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Navigating to UIC University

From the UKG homepage:

1. Click on Menu

2. Click on Career Development 

3. Click on UIC University
(under ‘Things I Can Do’)
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UIC University Dashboard
Once you are logged into UIC 
University, you are brought to 
the Employee Dashboard which 
is the homepage. The 
navigation on the left side of 
your screen allows you to find 
training courses, transcripts, 
and more.

You will also see 
announcements from your 
Human Resources UIC 
University team, and a list of 
your registered courses along 
with your training history. 
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UIC University – Your Training

You will need to complete your 
Code of Business Ethics & 
Conduct training on UKG.

1. Click on Assigned Courses

2. Click Code of Business 
Ethics and Conduct

Note: 
Use the search function if it 
does not appear in your queue.

Code of Business Ethics & Conduct
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UKG Password Management

IMPORTANT FOR NEW EMPLOYEES
Prior to accessing any UIC websites (such as Webmail or UKG) you must register on the Password 
Management Site first.

To complete your registration:

1. Visit the website http://reset.uicportal.com.

2. Click on the Edit My Profile link.

3. Log in using the Username and Password provided by your manager.

4. Set answers to the three security questions.

If you forget your password in the future, you will be able to reset it by answering the three security 
questions.

After completing registration, you must change your password.

To change your password:

1. Return to the homepage.

2. Click on the Change my Password link.

You can choose one of the two options:

a) Click on the Generate Password button to automatically generate a password.

b) Click the Reset Password button to manually enter a password.

Password must be a minimum of 8 characters and meet the following complexity 
requirements:

• At least 1 uppercase character (A through Z)
• At least 1 lowercase character (a through z)
• At least 1 numerical digit (0 through 9)

Help Desk 
helpdesk@uicalaska.com

.....................................................................................................

http://reset.uicportal.com/
mailto:helpdesk@uicalaska.com


35Proprietary Information – Do not distribute WWW.UICALASKA.COM

Payroll and Timesheets
UIC Corporate & Commercial
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Payroll

Pay Schedules
 Employees are paid weekly. 

First paycheck
 Your first paycheck will be mailed to the address that we have on file via US Postal Service.  Checks are mailed 

from the Anchorage office and can take up to 7 business days to receive. 

Important Note
 If you are planning to move prior to the pay date, please reach out to the payroll department as soon as possible 

so that we can ensure your check is mailed to the correct address.

Direct Deposit
 All direct deposits must go through a pre-note process to verify your bank account and routing numbers. This 

process takes 2 pay periods to complete. If you plan to switch banks or add a new account, this will restart the pre-
note process. 

Payroll Contact Information
 The Payroll email is:  UICCS_PR@uiccs.com.
 You may contact Payroll for general payroll inquiries such as: not receiving your pay check, benefit deduction 

questions, W2 request, pay statements, etc.

 Payroll assistance is available Monday – Friday, 8am – 5pm (AKST).

Note: Whenever the payday falls on a holiday, your pay will be issued the previous work day.

mailto:UICCS_PR@uiccs.com
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Timesheets

 For SL Databasics Companies

▫ Navigate to Databasics.UICAlaska.com

• Your Employee ID is your User ID which Human Resources 
and/or your supervisor will provide to you.

• You are required to “Request Password” at initial login.

 For Timberline Companies

▫ Navigate to https://udpb.hh2.com/WebApp/v2/Default.html

▫ Payroll will provide login credentials to you.

Links to Your Timesheet

.....................................................................................................

https://udpb.hh2.com/WebApp/v2/Default.html
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Viewing Pay Statements

 Log-in to UKG Pro at hr.uicalaska.com.  
▫ Once you log in, either the home screen or the select company screen will display. If the select company 

screen displays, select the company that you are actively employed by to continue to the UKG Pro home 
screen.

 Select Menu  Myself  Third Party Pay (under ‘Pay’).
 Your pay history will display.
 You can select specific pay dates for you to view your pay data for that specific pay date or you can simply click 

the search button all of your pay data will appear. 
 You can also view your current PTO balance on the pay statement.

UICCS employees are able to access their pay statements on UKG Pro

Click here

https://hr.uicalaska.com/
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Pay Statement Preference

Your pay statement preference will default to Electronic Copies Only*.  If you would like to receive a paper pay 
statement in the mail, you will need to opt in.  

To OPT IN: 

 Log-in to UKG Pro at hr.uicalaska.com.

 Navigate to Menu Myself  Direct Deposit (under ‘Pay’).

 Select ‘Change Pay Statement Preference’.

 Elect ‘Paper and electronic copies’.

 Click Save.

*Except where mailed pay statements are required by law, all pay statements will default to electronic copies. 
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Helpful Information

UICCS Email
Login instructions for your company email will be sent to your supervisor. Please 
check periodically for important company communications.

Corporate Databasics Timekeeping System
Corporate timecards are accessed through the Databasics system, at 
https://site40.data-basics.net/uicv600215/databasics.ext

Commercial Timekeeping System
UIC Commercial timecards can be found at: 
https://udpb.hh2.com/WebApp/v2/Default.html

UKG Pro
The UIC UKG Pro system contains useful information on benefits, password 
management, web mail and employee handbook. You can access the system at 
hr.uicalaska.com.

Reminders

.....................................................................................................

https://site40.data-basics.net/uicv600215/databasics.ext
https://udpb.hh2.com/WebApp/v2/Default.html
https://hr.uicalaska.com/
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Employee Benefits
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Full Time Employee Benefits

 Holidays (please refer to your new hire packet for holiday schedule) *

 Leave *

 Health: Medical, Vision, Prescription and Dental

 Flexible Spending Account – Dependent Care & Parking and Transit

 Life Insurance

 Accidental Death or Dismemberment (AD&D)

 Supplemental Life Insurance for Employee, Spouse, and Dependents

 Short Term Disability

 Short Term Disability Buy-up

 Long Term Disability

 Critical Illness Plan

 Tricare Supplemental Plan (for our men and women of service)

 Tuition Assistance (eligibility determined by contract and manager approval) *

* Full Time-Temporary and Full time/Part time Skilled Trade Employees are not eligible



43Proprietary Information – Do not distribute WWW.UICALASKA.COM

Premera

Eligibility
 You are eligible for most UIC benefits on the first of the month following your date of hire, or 

on your hire date if it coincides with the first day of the month, and you are a full-time 
employee scheduled to work a minimum of 30 hours per week.

How to Enroll
 Log into the UKG Pro system. Directions for login are sent to you in an email.

How to Register (2 options)
 Go online to http://www.premera.com/

▫ Find a doctor or service
▫ Review Explanation Of Benefits (EOBs)
▫ Compare cost for medical services
▫ Submit claims
▫ Order ID cards
▫ And more!

OR

 Call Premera’s Customer Service Line for assistance (844) 236-1842
Monday – Friday, 8:00am to 6:00pm Pacific Time

Premera also has a mobile APP available for Android, iPhone and Windows mobile devices.

Medical Insurance Enrollment and Registration

.....................................................................................................

http://www.premera.com/
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Benefits Enrollment in UKG Pro
 You have 30 days from your date of initial 

eligibility to enroll in benefits.

 Select Myself > Life Events > I am a new 
employee

 Please remember to add any dependents that 
you want on your insurance plans.

 The system will take you through each and every 
benefit option and you have to either elect or 
decline each one to move forward.

 Confirm your elections when you are finished 
and click Submit.
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Benefits: Mid-Year Changes

 Once you are enrolled, you must wait until the next Open Enrollment period to change your benefits 
unless you have a qualified change in family status as defined by the IRS.

*You must provide HR with certification within 30 days of the qualified life event.

 Examples of qualifying life events include, but are not limited to:

▫ Marriage, divorce, legal separation, or annulment.

▫ Birth or adoption of a child.

▫ Change in your workplace (if your benefit options change).

▫ Loss of other health coverage.

▫ Change in your dependent’s eligibility status because of marriage, age, 
etc.
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Consumer Driven Plan with HRA Consumer Driven Plan with HSA High Deductible Basic Plan (with 
or without HSA – employee’s 

choice)

Annual In Network 
Deductible 

$2,000 individual / $4,000 family $1,500 individual / $3,000 family $5,000 individual/$10,000 family

UIC Fund contribution $750 individual/ $1,500 family $750 individual/ $1,500 family _

In Network Out of 
pocket Maximum

$3,000 individual / $6,000 family $3,000 individual / $6,000 family $6,000 individual/$12,000 family

Coinsurance 
(the percentage covered 
by the plan)

80% In-network / 
60% Out-of-network

*after deductible

80% In-network / 
60% Out-of-network

*after deductible

70% In-network / 
50% Out-of-network

*after deductible

Preventive Services Covered at 100%, no deductible Covered at 100%, no deductible Covered at 100%, no deductible

Prescriptions - Retail              
(30-day supply)

Prescriptions - Home 
Delivery (90-day 
supply)

After Deductible, except for 
preventive prescriptions

$10 / $30 / $50
Self-administered injectables:
You pay 30% to a max of $150

$20 / $60 / $100
Self-administered injectables:
You pay 30% to a max of $300

After Deductible, except for 
preventive prescriptions

$10 / $30 / $50
Self-administered injectables:
You pay 30% to a max of $150

$20 / $60 / $100
Self-administered injectables:
You pay 30% to a max of $300

After Deductible, except for 
preventive prescriptions

$10 / $30 / $50
Self-administered injectables:
You pay 30% to a max of $150

$20 / $60 / $100
Self-administered injectables:
You pay 30% to a max of $300

*Please refer to your plan documents for more detailed information
*UIC Fund Contribution will be prorated based on your date of hire

Medical Insurance
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* Please consider contributions you may have made to other Health Savings Accounts in the same calendar year when choosing your
HSA contribution amount.

HRA HSA

Who contributes? Employer Employer and/or employee

Are there contribution limits? No, only the Employer can fund
* Yes; for 2021: $3,600 for employee 

only or $7,200 for employee and 
dependent coverage

Who owns the account? Employer Individual/Employee

Are funds portable? No Yes

Do funds rollover year to year? Yes Yes

What happens if I leave the Company? Funds are forfeited HSA balance remains with the 
employee

What expenses are eligible? Medical only All IRS Code 213(d) expenses

Can I use the account for non-medical expenses? No Yes, but are taxable

Can I also have an FSA? Yes Only a limited-purpose FSA 
(dental/vision)

HRA and HSA Comparison
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Company Contribution
HRA

Employee / Employee + 
Dependent(s)

HSA
Employee / Employee + 

Dependent(s)

Upon enrollment in the plan $375/$750* -

Within 60 days of completing health assessment 
and physical activity requirement $375/ $750 $375 / $750

Incrementally on a per pay period basis through 
December - $375/ $750*

Total Company Contribution: $750/$1500 $750/$1500

* Company contribution will prorated based on your date of hire

HRA and HSA Funding



49Proprietary Information – Do not distribute WWW.UICALASKA.COM

Wellness Incentive Program

To earn your incentive, you and your spouse (if applicable) must complete these 
activities on the Virgin Pulse Wellness Platform:

1. Complete a Health Assessment
AND

2. Complete one of these two activities:

 Log 300 minutes of activity or 60,000 steps either by syncing an activity device or 
logging points.

 Receive a preventative service.

You should see your incentive in your account within 90 days after you complete both actions. 

Remember, your incentive will be:

 $375 contribution to your Health Savings Account or your Health Care 
Reimbursement for employee only coverage.

 $750 contribution to your Health Savings Account or your Health Care 
Reimbursement for employee plus dependent coverage.

How to earn your incentive for 2021

All Actions must be completed by December 31, 2021

.....................................................................................................
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Telehealth through Premera
What is Telehealth?
The telehealth options are an added benefit to you through Premera.  It allows you to obtain healthcare with a national network 
of U.S. board-certified doctors and pediatricians through virtual talk or secure text.

What is it for? 
Diagnosing and treating common illnesses including, but not limited to, colds & allergies, migraines & headaches, bronchitis, 
upper respiratory infections, nasal congestion, and the flu. Prescription drugs can even be prescribed if necessary.

Who is eligible to use it?
If you are enrolled in the Company medical plan, you are eligible to utilize the Telehealth benefit options.

Options: 
• Doctor on Demand

Connect with doctors and psychologists via live video.

• MyCare Alaska
Chat-first virtual care platform via text.

• Talkspace
Connect to behavioral health professionals by video and text for about the same cost as an in-person visit.

• Boulder Care
Comprehensive approach to addiction therapy in the form a digital treatment program for Opioid Use Disorder (OUD).

• Premera Pulse (Text “Pulse” to 24248 to activate your account)
Digital resource through Premera designed to deliver personalized health information.

Please refer to your plan documents for more detailed information



51Proprietary Information – Do not distribute WWW.UICALASKA.COM

Service Contract Waivers

• Employees who support a contract subject to the Service Contract Act (SCA) 
who do not enroll in a UIC medical plan will automatically be enrolled in 
employee only coverage on the High Deductible Basic medical plan, unless
a waiver form and proof of other qualified coverage are provided.

• The SCA waiver can be found on the homepage of UKG Pro.

• The waiver and proof of other qualified coverage can be uploaded to the 
UKG Pro site by logging in and going to:
Myself > Documents > Add (green button) > Choose File > Add Document Title 
(i.e. John Smith waiver) > Select Category as ‘SCA Waiver’ > Save (green 
button)

Please refer to the UIC Service Contract Act (SCA) Benefits Policy (UIC-HR-2-6-091 Rev 1) for additional 
information regarding the calculation of the health and welfare (H&W) used to meet the H&W requirements under 
the Service Contract Act (SCA).

Service Contract Act / Davis Bacon Act 

UPLOAD DOCUMENT
→ Myself
→ Documents
→ Add (green button)
→ Choose File
→ Add Document Title

(i.e. John Smith waiver)
→ Select Category as 

‘SCA Waiver’ 
→ Save (green button)

.....................................................................................................

! IMPORTANT!
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Aetna Dental Coverage

Core Plan and Buy-Up Plan

Core Plan
$1500 Annual Maximum

Preventive Treatment

Covered in Full: 

Cleaning, x-rays, exams

Basic Treatment

You pay 20% 

Filling, extraction, root canal

Major Treatment

You pay 50% 

Dentures, Bridges, Crowns

Buy-Up Plan
$2500 Annual Maximum

Preventive Treatment

Covered in Full: 

Cleaning, x-rays, exams

Basic Treatment

You pay 20% 

Filling, extraction, root canal

Major Treatment

You pay 50% 

Dentures, Bridges, Crowns

Orthodontia

You pay 50%

Up to a $5,000 lifetime maximum

Deductibles

• Individual $50

• Family $150 .....................................................................................................
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VSP Vision Coverage

The vision plan includes benefits for eye exams, eyeglasses, and contact lenses 
through VSP.
 Eye exam (every 12 months) with a $20 copay In-Network

 Lenses (every 12 months)

 Contacts (every 12 months)

 Frames (every 24 months)

Vision Care Plan

Please refer to your plan documents for more detailed information

.....................................................................................................
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Benefits Emergency Contact

 Premera
Group Number: 4002747
ID Number: Use your Social Security Number until a number is assigned.
Customer Service: (844) 236-1842

 Aetna Dental
Group Number: 847008 (ID Card must be printed from www.aetna.com)
ID Number: Use your Social Security Number until a number is assigned.
Customer Service: (877) 238-6200 

 VSP Vision
Group Number:  30032318 (No ID Card will be issued)
ID Number: Provide your vision provider with your Social Security Number 
and they will be able to verify your benefit coverage with VSP.
Customer Service: (800) 877-7195

If you or a covered member of your family needs emergency doctor or 
hospital care before you receive your insurance card, give the caregiver 
this information:

.....................................................................................................
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Flexible Spending Accounts

 Set aside up to $2,750 before taxes for qualified healthcare expenses.
 Access entire amount on 1st day of plan year.
 Use money for eligible out-of-pocket medical expenses such as deductibles and copays.
 If you are enrolled in the HDHP with HSA, sign up for the Limited FSA (Dental & Vision 

only).

When enrolling, keep in mind: 
▫ Use it or lose it plan.
▫ You must re-enroll each plan year.

HealthCare Flexible Spending Account 

Maximum Annual Contributions:
 Dependent Care FSA = $5,000 ($2,500 if married and filing a separate tax return).

When enrolling, keep in mind:
▫ Use it or lose it plan.
▫ You must re-enroll each plan year.
▫ The IRS specified maximum is $5,000 per year.
▫ Remember to include amounts you contributed at any previous employer(s) during the 

calendar year.

Dependent Care Flexible Spending Account

.....................................................................................................
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Flexible Spending Accounts

Allows Employees to set aside “pre-tax dollars” for qualifying transportation and 
parking expense reimbursement.  

Annual IRS Limits:

Transit Account:  $270 per month

Parking Account:  $270 per month

Stipulations:

 Changes must be submitted 2 weeks prior to effective date.
 Claims must be submitted within 180 days of the incurred expense.
 You must re-enroll each plan year.

Commuter / Parking Benefit

Please refer to your plan documents for more detailed information

.....................................................................................................
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* This voluntary program is only available to employees and their dependents who are eligible for Tricare

TRICARE Supplemental Plan administered through SelmanCo
• Plan Deductible of $100 per individual and $200 per family
• After you have met both your TRICARE and TRICARE Supplement Plan deductibles, the supplemental 

insurance pays 100% of your approved expenses not paid by TRICARE.

Care Required Tricare Select Pays The Supplement Plan Pays

Annual Deductible Non-Network: $150 for individual and 
$300 for family 100% of Tricare Deductible

Primary Care Outpatient Visit
Network: $28 or $41
Non-Network: 25% of TRICARE allowed 
amount

Network: $28 or $41
Non-Network: 25% of TRICARE allowed 
amount

Inpatient Admission

Network Provider: $250 per day, or up to 
25% hospital charge, whichever is less, 
plus 20% separately billed services

Out of network: $901 per day, or 25% 
hospital charge, whichever is less, plus 
25% separately billed services

Network Provider: $250 per day, or up to 
25% hospital charge, whichever is less, 
plus 20% separately billed services

Out of network: $901 per day, or 25% 
hospital charge, whichever is less, plus 
25% separately billed services

Tricare Supplemental Plan
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 Contributions are 100% vested

 To receive the maximum matching contribution, you must maintain a deferral percentage of at least 3% of all gross eligible 

wages each pay period.

 Employer match will begin with your first 401(k) contribution.

▫ For SCA employees, the employer match will be deducted from the H&W.

 Traditional 401(k) and Roth 401(k) options are available.

 Enrollment must be completed through UKG Pro.

▫ Visit hr.uicalaska.com.

▫ Username is your company network login and password.

 Investment elections, viewing statements, 401(k) loans, etc. must be done using the Wells Fargo site. 

 Register at www.wellsfargo.com 7-10 days after receiving your first paycheck.

401(k)

Employer matching 401(k) contribution can be as high as 3% of all gross eligible wages up 
to the annual maximum wages established by Federal law (please consider contributions 
under multiple employers in the same calendar year when choosing your contribution 
amount).

1-800-728-3123

http://www.wellsfargo.com/
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Company Insurance Coverage

All Fulltime Regular Employees Automatically Enrolled In:

 Life Insurance

 Accidental Death or Dismemberment

 Short-term Disability

 Long-term Disability

Employer Provided Life Insurance:
When employer-provided group term life insurance exceeds $50,000 for an 
employee, the value of the coverage over $50,000 must be reported as taxable 
income. The amount reported as taxable income is the cost of the benefit 
(determined by the IRS) not the benefit itself.  The calculated value is included on 
your pay advice and can be located under the Other Benefits and Information 
section – Group Term Life.
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Life and AD&D Insurance

UIC provides you with life and AD&D insurance coverage at no cost to you.

 You automatically receive 2x your annual earnings, up to $200,000.

 You must choose a beneficiary.

*Coverage above guarantee issue amount requires completion of an Evidence of Insurability Form

Basic Life and AD&D

You may enroll in voluntary life and accidental death and dismemberment coverage.

Voluntary Life and AD&D

Employees Spouses Children

Up to 5x your salary Up to 100% of employee’s 
coverage 

Up to 100% of employee’s 
coverage 

In $10,000 increments in $5,000 increments in $2,000 increments 

up to $500,000 up to $500,000 up to $10,000

$140,000 guarantee issue amount 25,000 guarantee issue amount -
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Disability Insurance

 As a full time employee, UIC provides you with base short-term disability which pays 
60% of your weekly earnings, to a maximum $1,500 per week for the first 13 weeks of a 
disability.

 Employees will have the option to purchase a buy-up plan.  With the supplemental buy-
up plan, you will receive 70% of your covered weekly earnings, up to $2,000 through the 
13th week of disability.

 Premiums are paid by the employee via payroll deductions.

Short-Term Disability & Buy-Up

Please refer to your plan documents for more detailed information

 As a full time employee, UIC provides you with base long-term disability which pays 60% 
of your base earnings, to a monthly maximum $7,500 if you are disabled for more than 
90 days and are unable to work.

 LTD benefits are offset by other sources of income.

Long-Term Disability

.....................................................................................................
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Voluntary Critical Illness

 Critical illness insurance pays a one-time lump sum benefit amount upon 
the diagnosis of a covered disease or illness such as invasive cancer, 
paralysis, heart attack, stroke, etc.

 You can use this money to cover lost wages, child care, travel, home care or 
regular household expenses.

 Pre-Existing Condition Limitation
▫ This plan will not pay benefits for a covered loss caused or contributed 

to by, or resulting from, a pre-existing condition.

Please refer to your plan documents for more detailed information

Covered Person Weekly

Employee $5,000, $10,000 or $20,000

Spouse 50% of employee benefit

Children 25% of employee benefit
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Benefits Information

Detailed benefit guides, documents and other benefits information can be found 
on our benefits website at:

MyBenefits.Life

Employer keys (passwords):
 For non-SCA employees located in Alaska: UICAlaska
 For non-SCA employees located in the Lower 48 states: UICL48
 For SCA employees: UICSCA

MyBenefits.Life

MyBenefits.Life

One-stop web portal and 

app for employees and their 

dependents to view benefit 

plan information provided 

by their employer

Download the Mobile App

Links to the benefit website can be found on the homepage of UKG Pro hr.uicalaska.com

.....................................................................................................

http://www.hr.uicalaska.com/
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Employee Assistance Program

Our Employee Assistance Program (EAP) can help you or your dependents find 
solutions for everyday challenges of work and home as well as more serious 
issues involving emotional and physical well-being.

UIC pays the entire cost for up to 6 EAP sessions per problem as needed for:

 Health and wellness 
 Child and elder care
 Family or parenting issues
 Work/Life balance
 Marital or relationship issues
 Pre and postnatal concerns
 Grief and loss

 Depression, anxiety and stress
 Alcohol or drug dependencies
 Health management support & referrals
 Legal consultation services with an attorney
 Financial Services
 Magellan Self-Screening System

Confidential in-person or telephone counseling or crisis services available 24 hours a day, 7 days 
a week.

Telephone Number:  (800) 478-2812
Online:  www.MagellanHealth.com/member

–Select Register or Enter as a Guest
–Program Number: 800-478-2812
–Organization name: Bowhead

.....................................................................................................
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More Benefits

My Secure Advantage Program
Provides resolution services to help you work through identity theft issues
Services to help build your will and other legal documents
Money coaching

Secure Travel Program
Provides emergency medical evacuation assistance and travel services when 
traveling 100 miles or more away from home

CIGNAssurance Program
Support and assistance such as counseling and financial guidance after the loss 
of a covered loved one

Health Advocate
Offers assistance with a wide rage of  healthcare and health insurance issues such 
as help with claims, scheduling appointments, test results etc. 

*Please refer to the Life & Disability section and the Resources section of the benefits information 
website for more detailed information.  
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Leave Benefits

Types of Leave
 Leave with Pay – Paid Time Off (PTO)

(PTO pay does not apply to part-time or temporary employees and typically will not apply to 
skilled trade employees.)

 Bereavement Leave

 Jury Duty and Witness Leave

 Military Leave

 Subsistence Leave

Eligibility and benefits may vary by contract.  Please refer to the following for 
more information.
 Employee Handbook

 Your UKG Onboarding Paperwork

Paid Time Off………………………...….98

Holiday Pay……………………...…..…102

Bereavement Leave………………......105

Jury Duty Leave…………………….…107

Military Leave……………………….….109

Inclement Weather Leave…….....…...115

Absent Without Leave……….………..117

Subsistence Leave………….………...120

Sick Leave With Pay……….…………128

Section 6 – Employee Time 
Off from Work
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Tuition Reimbursement

Tuition Reimbursement Policy
Pre-Approved Tuition *

Max of $5,250 per year for tuition and books

Training and Certificates
Pre-Approved Training and Certification

No dollar limit for training and certification

Eligibility Requirements for Both Programs
Regular-Fulltime Employee

90 Days of Service
Continuously Employed for the duration of each course

Financial Assistance
Education / Training / Certifications

* Not applicable for all contracts. Manager review and approval required.
* Fulltime-Temporary and Fulltime/Part time Skilled Trade Employees are not eligible for tuition assistance.
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Benefit Reminders

 Benefit Enrollment
▫ You will need to enroll in benefits as soon as possible after your eligibility date (the 

first of the month following your start date, or if your start date was the first day of 
the month, you are eligible for benefits on that day). 

 Benefit Premiums
▫ Regardless of when you enroll, you will be responsible for all benefit premiums 

based on your eligibility date. In the event your enrollment results in missed payroll 
deductions, you will be responsible for paying the missed premiums through 
additional payroll deductions. 

 Plan Year
▫ The plan year for all benefits runs calendar year, 1/1/2021 – 12/31/2021

 Wellness Incentive Program
▫ If you are enrolled in the HRA or HSA Medical Plan, you have the option to 

participate in our Wellness Incentive Program. Just complete an online health 
assessment and meet the physical activity requirement in 2021 to receive a lump 
sum company contribution to your HRA or HSA.

 Benefits Information Website
▫ More information regarding the wellness incentive can be found on the benefits 

information website under the Resources section (MyBenefits.Life).
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Welcome Aboard
We will take a quick break and 

the Safety Orientation will begin shortly.
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